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Preface 

The Juvenile Salmon Acoustic Telemetry System (JSATS) software user’s manual presented here 
describes the installation and use of the JSATS decoder software.  The software was developed for use 
with the JSATS cabled array system for decoding digitized acoustic signals.  A complementary manual 
describes the use of the detector software used for acquiring the acoustic signals and recording them to 
file.  This software was developed by the Pacific Northwest National Laboratory (PNNL) for the U.S. 
Army Corps of Engineers, Portland District to assist with estimating dam passage survival and other 
performance measures stipulated by the 2008 Federal Columbia River Power System Biological Opinion 
(BiOp) and the 2008 Columbia Basin Fish Accords. 

Many others made significant contributions to development and testing of this software including 
Tom Carlson, Eric Choi, Daniel Deng, Jayson Martinez, Adam Flory, Tylor Abel, Yong Yuan, and Tom 
Seim.  Thank you also to Joanne Duncan, Susan Ennor, George Batten, and Matt Hennen whose edits, 
comments, and improvements were much appreciated. 

iii 





 

Acronyms and Abbreviations 

AMT acoustic micro-transmitter 
bwm binary waveform format 
CPU central processing unit 
CRC cyclic redundancy check 
csv comma separated variable 
DSP digital signal processing 
FPGA field programmable gate array 
GPS global positioning system 
GUI graphical user interface 
I/O input/output 
JSATS Juvenile Salmon Acoustic Telemetry System 
ms millisecond(s) 
SNR signal-to-noise ratio 
TOA time of arrival 
 

v 





 

Contents 

Preface ..................................................................................................................................................  iii 
Acronyms and Abbreviations ...............................................................................................................  v 
1.0 Introduction ..................................................................................................................................  1.1 
2.0 System Requirements ...................................................................................................................  2.1 
3.0 Installation ....................................................................................................................................  3.1 

3.1 Decoder Installation .............................................................................................................  3.1 
4.0 Software Interface .........................................................................................................................  4.1 

4.1 Main Window .......................................................................................................................  4.1 
4.1.1 File Menu Bar ............................................................................................................  4.1 
4.1.2 Decoder Quick-Launch Bar.......................................................................................  4.3 
4.1.3 Decoder Options ........................................................................................................  4.4 
4.1.4 Save Commands ........................................................................................................  4.5 

4.2 Results Frame .......................................................................................................................  4.8 
4.2.1 Tag Code Row ...........................................................................................................  4.9 
4.2.2 File Length ................................................................................................................  4.9 
4.2.3 Context Menu ............................................................................................................  4.9 
4.2.4 Viewing Tag Code Data Waveforms ........................................................................  4.10 

4.3 Save and Display Options ....................................................................................................  4.12 
4.3.1 Save Only Valid Tagcodes Option ............................................................................  4.12 
4.3.2 Show Only Valid Tagcodes Option ...........................................................................  4.12 
4.3.3 Insert Results at Top of List Option ..........................................................................  4.13 
4.3.4 Display Tags Option ..................................................................................................  4.13 

4.4 Clear Results ........................................................................................................................  4.13 
5.0 Decoding .......................................................................................................................................  5.1 

5.1 Decoding a Single File .........................................................................................................  5.1 
5.2 Decoding a Directory ...........................................................................................................  5.2 

5.2.1 Selecting the Decoding Directory .............................................................................  5.3 
5.2.2 Include Sub-Directories Option.................................................................................  5.4 
5.2.3 Rename Extension After Decode Option ..................................................................  5.4 
5.2.4 Use Dates Option ......................................................................................................  5.5 
5.2.5 Maximum Number of Threads ..................................................................................  5.7 
5.2.6 How Do I Know It Is Decoding? ...............................................................................  5.7 
5.2.7 Stopping the Directory Decoding Process .................................................................  5.8 

5.3 Real-Time Decoding ............................................................................................................  5.9 
5.3.1 Real-Time Decoding .................................................................................................  5.9 
5.3.2 Include Sub-Directories .............................................................................................  5.12 

vii 



 

5.3.3 Rename Extension After Decode ..............................................................................  5.12 
5.3.4 Delete File After Decode ...........................................................................................  5.14 
5.3.5 Milliseconds Before Decoding ..................................................................................  5.14 
5.3.6 Maximum Number of Threads ..................................................................................  5.14 
5.3.7 Cache Expiration Time (mins) ..................................................................................  5.15 

6.0 Beacon Monitoring .......................................................................................................................  6.1 
6.1 Statistics and Beacon Monitoring Window ..........................................................................  6.1 
6.2 Adding a Beacon to the Statistics and Beacon Monitoring List ...........................................  6.2 
6.3 Deleting a Single Beacon .....................................................................................................  6.3 
6.4 Deleting All Beacons from the List ......................................................................................  6.3 
6.5 Editing a Beacon ..................................................................................................................  6.3 
6.6 Loading a Beacon File ..........................................................................................................  6.4 
6.7 Saving a Beacon File ............................................................................................................  6.5 
6.8 Setting Statistics Options and Saving Stats Options ............................................................  6.6 

6.8.1 Compute Statistics .....................................................................................................  6.7 
6.8.2 Time Period for Computing Statistics .......................................................................  6.7 
6.8.3 Tag Codes Required to Compute Statistics ...............................................................  6.7 
6.8.4 Ping Rate Tolerance ..................................................................................................  6.7 
6.8.5 Saving Statistics ........................................................................................................  6.8 
6.8.6 Saving Beacon Statistics ...........................................................................................  6.8 

6.9 Clearing Statistics .................................................................................................................  6.8 
7.0 Data and File Formats ...................................................................................................................  7.1 

7.1 Beacon File Format ..............................................................................................................  7.1 
7.2 Beacon Statistics File Format ...............................................................................................  7.2 
7.3 Decoder Results File Format ................................................................................................  7.2 

8.0 Command Line Decoder ...............................................................................................................  8.1 
9.0 References ....................................................................................................................................  9.1 
 
 
  

viii 



Figures 

1.1 Flowchart Depicting the Flow of Data for the JSATS Cabled Receiver ...................................  1.1 
1.2 Structure of the JSATS Cabled Array System and JSATS Software ........................................  1.2 
3.1 Windows Explorer Window Showing the JSATS Decoder Setup File .....................................  3.1 
3.2 JSATS Decoder Setup Wizard Dialog Box ...............................................................................  3.2 
3.3 Enter or Browse to the Chosen Installation Folder Location within the Installation Folder 

Dialog Box .................................................................................................................................  3.2 
3.4 Select the Next Button in the Confirm Installation Dialog Box to Initiate the Install 

Process .......................................................................................................................................  3.3 
3.5 Installation Progress Will Be Shown in the Installing JSATS Decoder Dialog Box.................  3.3 
3.6 The Successful Installation of the JSATS Decoder Will Be Shown in the Installation 

Complete Dialog Box ................................................................................................................  3.4 
4.1 JSATS Decoder Main Application Window Showing the Menu Structure ..............................  4.1 
4.2 TDOA6a Operating Options Adjustment Panel ........................................................................  4.2 
4.3 Error Log Window ....................................................................................................................  4.3 
4.4 TDOA6D Decoder Window ......................................................................................................  4.4 
4.5 TDOA6D Decoder Window ......................................................................................................  4.5 
4.6 Results Properties Dialog Box ...................................................................................................  4.6 
4.7 Results File Save As Dialog Box ..............................................................................................  4.7 
4.8 TDOA6D Results Are Shown in Spreadsheet Format in the Lower Frame of the Decoder 

Window .....................................................................................................................................  4.9 
4.9 The Context Menu Is Revealed by Right-Clicking on the Results Spreadsheet........................  4.10 
4.10 Resize the Results Spreadsheet by Repositioning the Scroll Bar ..............................................  4.11 
4.11 Resized Results Space after Repositioning the Scroll Bar ........................................................  4.11 
4.12 Save and Display Options..........................................................................................................  4.12 
4.13 Tag Code Values with a G Prefix Are Displayed when the Show Only Valid Tagcodes 

Option is Selected ......................................................................................................................  4.13 
4.14 Clear Results Option ..................................................................................................................  4.14 
4.15 Confirm Data Clear Alert Box ...................................................................................................  4.14 
5.1 Decoder Command Bar Options ................................................................................................  5.1 
5.2 Decode File Open File Dialog Box ...........................................................................................  5.2 
5.3 Decoder Directory Options Dialog Box ....................................................................................  5.3 
5.4 Decode Directory Browse for Folder Dialog Box .....................................................................  5.4 
5.5 Decoder Directory Selection Options ........................................................................................  5.5 
5.6 Selecting the Decode Start Date and Time from a .bwm File ....................................................  5.6 
5.7 Updating the Calendar Using Set From and Set To Times .......................................................  5.6 
5.8 Select Ok to Start the Decoding Process ...................................................................................  5.7 
5.9 Options at the Top of the Decoder Window Are Disabled during the Directory Decoding 

Process .......................................................................................................................................  5.8 

ix 



5.10 Select the Stop Decoding Button to Terminate a Directory Decode .........................................  5.9 
5.11 Real-Time Decoding Option .....................................................................................................  5.10 
5.12 Real-Time Decoder Options Dialog Box ..................................................................................  5.10 
5.13 Real-Time Decoder Directory Selection ...................................................................................  5.11 
5.14 Real-Time Decode Directory Browse for Folder Option Dialog Box .......................................  5.12 
5.15 Real-Time Decoder Options Dialog Box ..................................................................................  5.13 
5.16 The JSATS Decoder Configuration File Is Commonly Located in the Program Files 

Directory ....................................................................................................................................  5.13 
5.17 The File Extension for Renamed Files Can Be Changed by Modifying the Configuration 

File .............................................................................................................................................  5.14 
6.1 Statistics and Beacon Monitoring Options ................................................................................  6.1 
6.2 Edit Beacon Dialog Box ............................................................................................................  6.2 
6.3 To Delete a Beacon, Highlight the Row and Select Delete .......................................................  6.3 
6.4 The Confirmation Dialog Box to Delete All Beacons on the List .............................................  6.3 
6.5 Beacon List File Example Using Notepad ................................................................................  6.4 
6.6 The Text File Containing Beacon Information Is Selected from the Open File Dialog Box ....  6.4 
6.7 Beacon List Loaded from an ASCII Text File ..........................................................................  6.5 
6.8 When Saving a Beacon List the Save As Dialog Box Opens, Prompting Insertion of a File 

Name .........................................................................................................................................  6.6 
6.9 Statistics Options Dialog Box ....................................................................................................  6.7 
6.10 The Open Dialog Box where Beacon Statistics Will Be Saved ................................................  6.8 
7.1 Beacon File Format Example ....................................................................................................  7.1 
7.2 Beacon Statistics File Format ....................................................................................................  7.2 
7.3 Results File Format ....................................................................................................................  7.3 

x 



1.0 Introduction 

The Juvenile Salmon Acoustic Telemetry (JSATS) system uses acoustic transmitters and receiving 
systems to track fish in one, two, or three dimensions (McMichael et al. 2010; Deng et al. 2011; Weiland 
et al. 2011).  A modular JSATS array consists of software, a computer, multifunction electronic cards 
including a global positioning system (GPS) card, and digital signal processing (DSP) cards with field 
programmable gate array (FPGA) capability, a signal conditioning interface, four hydrophones, and four 
cables (Weiland et al. 2011).  The conditioned signal enters the signal processing environment of the host 
computer where messages from JSATS transmitters are detected, decoded, and time stamped (Figure 1.1). 

Figure 1.1.  Flowchart Depicting the Flow of Data for the JSATS Cabled Receiver 

The JSATS cabled array is an integrated system of off-the-shelf and custom components (Figure 1.2) 
designed for detection and tracking of fish tagged with acoustic micro-transmitters (AMTs) as they pass 
through the hydrophone array.  This system was initially designed for use at hydroelectric facilities to 
track fish as they approach and pass the dam, but it can be adapted for many types of environments.  The 
signal transmitted by the AMT implanted in a fish is detected by hydrophones deployed in known 
locations (surveyed positions).  This signal is amplified by the hydrophone, or hydrophones, on which the 
signal is detected and passed through cables to a receiver where the signal is conditioned and further 
amplified.  The signal is then passed to the DSP/FPGA card in the computer for signal verification and 
acceptance.  The signal is paired with the time from the GPS card to provide microsecond accuracy and 
then the data are written to disk as a .bwm (binary waveform format) file.  If the decoder is running in the 
real-time mode and is able to keep up with the signals coming in, the file is opened, decoded, and the tag 
code decoded from the acoustic waveform is written to a .csv (comma- separated variable) file for use in 
future analysis not described in this manual.  If the real-time decoder is unable to keep up with the stream 
of incoming .bwm files or the data are not being decoded in real-time the .bwm files will be decoded later 
(post-processed) using the Decode Directory function described in Section 5.2.  

The JSATS decoder, explained in detail in this manual, is a software application that converts a 
digitized acoustic signal (a waveform stored in .bwm files) into a list of potential JSATS AMT tag codes 
along with other descriptive data about the signal, including time of arrival (TOA) and signal-to-noise 
ratio (SNR).  The software is capable of decoding single files, directories, and viewing raw acoustic 
waveforms.  When coupled with the JSATS detector, the decoder is capable of decoding in real time and 
can also provide statistical information about acoustic beacons placed within the detection range of 
hydrophones within a JSATS array.  This field manual details the features and functionality of the JSATS 
decoder software. 

1.1 



Figure 1.2.  Structure of the JSATS Cabled Array System and JSATS Software 

System requirements (Section 2.0) are presented first, followed by software installation instructions 
(Section 3.0), instructions for decoder setup (Section 4.0), decoding process initiation (Section 5.0), and 
monitoring of beacons using real-time decoding features (Section 6.0).  Section 7.0 explains data and file 
format configurations, and Section 8.0 describes the Command Line decoder, a lightweight version of the 
JSATS decoder. 
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2.0 System Requirements 

This section provides information about the minimum system requirements for operation of the 
JSATS decoder. 

Hardware Requirements 

Decoder only 

Requirement 
System Component Minimum Recommended 
Processor 1 GHz 2 GHz multicore or greater 
RAM 512 MB 4 GB or greater 
Disk Space Installation 2.5 GB 2.5 GB 

Additional disk space is required for storing decoded waveform data.  The amount of hard drive space 
needed depends on the number of .bwm files being decoded and the data stored in the individual .bwm 
files. 

Decoder/Detector 

Requirement 
 System Component Minimum Recommended 
Processor Pentium IV 2 GHz multicore or greater 
RAM 1 GB 4 GB or greater 
Disk Space Installation 2.5 GB 2.5 GB 
PCI-X slots 3 3 

Additional disk space is required for acquisition of raw .bwm files and storing decoded waveform 
data.  The amount of hard drive space needed depends on the number of .bwm files being acquired and 
decoded and the data stored in the individual .bwm files. 

Operating System Requirements 

• Windows 7 (32- or 64-bit)

• Windows XP (Service Pack 2 or 3)

Required Utility Packages 

• .net Framework 4.0 – (http://www.microsoft.com/download/en/details.aspx?id=17718) – link
accessed on December 12, 2012.

• VC++ Redistributable 8.0 (the appropriate package for your computer’s operating system, i.e., x86
for 32-bit operating systems and x64 for 64-bit systems).
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– 32-Bit – (http://www.microsoft.com/downloads/details.aspx?FamilyID=9b2da534-3e03-4391-
8a4d-074b9f2bc1bf&displaylang=en) – link accessed on December 12, 2012 

– 64-Bit – (http://www.microsoft.com/downloads/details.aspx?familyid=90548130-4468-4BBC-
9673-D6ACABD5D13B&displaylang=en) – link accessed on December 12, 2012 
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3.0 Installation 

This section provides instructions for installation of the JSATS decoder.  The software packages 
listed in Section 2.0 must be installed prior to the installation of the JSATS decoder.  Instructions for 
installation and use of the JSATS detector software are provided in a companion manual, the JSATS 
Detector Software Manual. 

3.1 Decoder Installation 

The JSATS decoder installation file “SetupJSATSDecoderOTR.msi” is available from 
http://jsats.pnnl.gov/Software/. 

In Windows Explorer, start the installation by double-clicking the file 
“SetupJSATSDecoderOTR.msi” (Figure 3.1). 

 
Figure 3.1.  Windows Explorer Window Showing the JSATS Decoder Setup File 

After the installer loads, you will be guided through a series of steps, beginning with the Setup 
Wizard dialog box (Figure 3.2).  Select Next to continue installation. 
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Figure 3.2.  JSATS Decoder Setup Wizard Dialog Box 

The first step of installation is to identify the folder in which you want to install the decoder.  The 
default location for the installation folder is in the computer Program Files Directory, as shown in the 
Select Installation Folder dialog box in Figure 3.3.  An alternative installation location may be entered in 
the Folder text box, or Browse can be selected to navigate to a designated folder location.  Select the 
option button to choose whether or not the JSATS decoder will be available for others that may use the 
computer, and select Next. 

 
Figure 3.3. Enter or Browse to the Chosen Installation Folder Location within the Installation Folder 

Dialog Box (first install screen) 
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The Select Installation Folder dialog box will close and the Confirm Installation dialog box  
(Figure 3.4) will open.  Select Next to confirm that you want to install the decoder and to initiate the 
software installation. 

Figure 3.4. Select the Next Button in the Confirm Installation Dialog Box to Initiate the Install Process 
(second install screen) 

The progression of the decoder installation will be indicated by the progress bar shown in the 
Installing JSATS Decoder dialog box (Figure 3.5).  When completed, select Next. 

Figure 3.5. Installation Progress Will Be Shown in the Installing JSATS Decoder Dialog Box (third 
install screen) 

3.3 



 

A new dialog box will open indicating the successful installation of the JSATS decoder  
(Figure 3.6); select the Close button to complete the installation process. 

 
Figure 3.6. The Successful Installation of the JSATS Decoder Will Be Shown in the Installation 

Complete Dialog Box (final install screen).  Select the Close button to complete the process. 
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4.0 Software Interface 

This section provides a descriptive overview of the layout and the function of the GUI (graphical user 
interface) and how to navigate the software to set preferences for viewing and decoding data. 

4.1 Main Window 

Figure 4.1 shows the layout of the main JSATS Decoder window.  The menu structure is organized 
into five main categories (bordered in red):  the File Menu Bar (Section 4.1.1), Decoder Quick Launch 
Bar (Section 4.1.2), Decoder Command Bar (Section 5.0), Decoder Options (Section 4.1.3), and Save 
Commands Bar (Section 4.1.4).  Four of these elements are described in the following sections. 

Figure 4.1.  JSATS Decoder Main Application Window Showing the Menu Structure 

4.1.1 File Menu Bar 

The top level File Menu Bar contains several menus and sub-menus. 
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4.1.1.1 File Menu 

The File menu allows you to quit the program (Exit), save results (Save, Save As), and decode .bwm 
files (Decode File, Decode Directory).  The Decode File and Decode Directory options are described in 
Section 5.0. 

4.1.1.2 Edit Menu 

The Edit menu allows you to change decoder options.  The decoder available with this software 
package, TDOA6D, has options that can be modified to optimize the processing of saved tag waveforms 
or detector output.  The default options described have been tested and optimized for detector algorithm 
performance.  To adjust decoder parameters, select the specific decoder (i.e., TDOA6D) options in the 
dropdown Edit menu, which will open the decoder operation adjustment panel (Figure 4.2).  The options 
and preset parameters, shown as TDOA6a Options in Figure 4.2, are identical to TDOA6D options.  It is 
recommended that these options not be adjusted without thoroughly testing the changes.  The variables in 
the Options dropdown menu are not discussed in this manual. 

Figure 4.2.  TDOA6a Operating Options Adjustment Panel 

4.2 



 

4.1.1.3 View Menu 

The View menu allows you to hide the status bar or to display application log or error messages.  
When application errors occur, they will be displayed in the Error Log window (Figure 4.3).  Click on 
the Clear button in the lower right corner of the screen to clear the log file or click on OK to return to the 
main application screen. 

 
Figure 4.3.  Error Log Window 

4.1.1.4 Tools Menu 

The Tools menu allows you to load other decoders not packaged with this software.  The JSATS 
decoder system is plug-in based to permit developers to install and test new decoders without having to 
construct a user interface or other features.  The extension of this decoder through plug-ins is not 
discussed in this user manual. 

4.1.1.5 Windows Menu 

The Windows menu displays a list of the decoder and log windows currently loaded, allowing the 
user to toggle through the available views.   

4.1.2 Decoder Quick-Launch Bar 

The JSATS decoder should automatically load one of the decoder windows upon startup; currently 
TDOA6D is the only decoder version loaded when the software is installed.  If a decoder window is not 
loaded and opened, you can select the decoder from the decoder quick-launch bar by clicking on the 
decoder name (Figure 4.1). 

When you select the TDOA6D decoder, the window shown in Figure 4.4 will open. 
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Figure 4.4.  TDOA6D Decoder Window 

4.1.3 Decoder Options 

Each decoder has options that can be adjusted to control its performance.  To adjust decoder 
parameters click the Decoder Options button in the main Decoder window (Figure 4.1).  

Decoder operation options can also be changed by selecting the Edit menu, and then selecting the 
Decoder Options item as described in Section 4.1.2.   

After changing the decoder operation parameters, select OK to accept the changes, or Cancel to 
reject any modifications.  The default options have been thoroughly tested and verified in the lab and 
field.  Any changes made to settings should be tested before they are implemented.  Improper setting 
adjustment may result in reduction in decoding efficiency and other undesirable effects on decoder 
performance. 
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4.1.4 Save Commands 

4.1.4.1 Result/Save Options 

The Result/Save Options menu allows you to specify where result files will be saved.  When the 
decoder decodes a directory (in real time or during post-processing), the results are saved to a file in a .csv 
format.  In the Result/Save Options menu you can adjust save parameters and display properties.  To set 
these program parameters, click on the Result/Save Options button  
(Figure 4.5). 

Figure 4.5.  TDOA6D Decoder Window (with the Results/Save Options and Save Results buttons 
outlined in red) 

After selecting the Result/Save Options menu item, the Results Properties dialog box shown in 
Figure 4.6 will appear. 
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Figure 4.6.  Results Properties Dialog Box 

Enter preferred values in the Results Properties dialog box, which are described in the next 
subsections, and select OK to accept or Cancel to reject changes. 

Results Filename 

The Results Filename text box in the Results Properties dialog box specifies two things:  the 
directory where the file will be saved and the base file name.  For example, Figure 4.6 shows that the file 
results.csv will be saved to the C:\Users\d3f041\Desktop\Decoder directory. 

The name of each results file created by the decoder program is unique in the sense that all data will 
not be saved into a single file with the name “results.csv”; instead, the decoder will create a unique file 
name by appending the date the data were processed and the directory where the decoded file was located 
to the output file name.  This feature assists with data management.  For example, if files located in 
directory “c:\temp\jsatsStudy” were decoded on April 22, 2010, the output file name assigned by the 
decoder would be 

Results_20100422_1_jsatsStudy.csv. 

To have the decoder append a number to the Results Filename when data are reanalyzed, check the 
Append data if file names are the same box (Figure 4.6).  The decoder will append the new data to 
those already in the file instead of creating a new file for the reanalysis, keeping the file name the same as 
the original, as shown below: 

Results_20100422_1_jsatsStudy.csv. 
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The directory location can be edited by entering a new directory path and file name into the Filename 
text box or by clicking the Browse button, which will bring up the file Save As dialog box (Figure 4.7). 

Figure 4.7.  Results File Save As Dialog Box 

Navigate to the directory to which you wish to save your results files, then enter the file name to be 
saved as described above and click Save. 

Input/Output Memory Cache Length 

As the decoder runs it handles several files (post-processing, real-time) and performs many file saving 
and file management operations.  These input/output (I/O) operations can significantly slow processing 
because of computer disk performance inefficiency during access.  The I/O Memory Cache Length 
parameter (Figure 4.6) allows the decoder to retain tag code results in a memory buffer until the buffer is 
filled to its specified capacity.  Then the program performs a single block operation to write results to the 
disk.  This reduces the number of disk access operations during processing and improves performance.  
By default, the decoder buffer is set to hold 1000 tag codes before writing the data to file. 

Display at Most Tags on Spreadsheet 

The Display at Most Tags on Spreadsheet feature, which is accessible through the Results 
Properties dialog box (Figure 4.6), permits the modification of the maximum number of tag codes 
displayed in the results spreadsheet list.  By default, this number is 1000.  The tag codes displayed will be 
those most recently obtained by the program.  Increasing this number will greatly reduce decoder 
performance by consuming computer resources. 
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Color Code Channels 

The Color Code Channels checkbox option allows data channels to be displayed in color (green, red, 
yellow, blue) or grayscale format.  This feature confirms that acoustic data are being received on 
individual hydrophones during program setup (Figure 4.6). 

4.1.4.2 Save Results 

The decoder automatically saves the results as it processes acoustic signals. 

4.2 Results Frame 

The Results frame, shown in the lower half of the JSATS Decoder window, displays a spreadsheet 
listing tag codes and other relative data, obtained when .bwm files are decoded (Figure 4.8).  Information 
displayed in this spreadsheet includes the following:  

• # (a decode index value)

• Path (the directory for the processed file)

• Filename (name of the .bwm file)

• Tagcode (prefixed with G for good, B for bad based on checksum values)

• Hydrophone Name (the name for the hydrophone set in the detector software and contained in the
processed file)

• TOA (time of arrival)

• SNR (signal-to-noise ratio)

• CRC (cyclic redundancy check).  Checksum computed over the 16-bit binary representation of the
tag code

• Date (date acquired)

• Seconds from Midnight (when the file was created)

• Absolute Time (seconds from midnight plus the TOA)

• Phase Margin (a confidence metric for binary phase-shift keying phase transitions)

• Channel.
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Figure 4.8. TDOA6D Results Are Shown in Spreadsheet Format in the Lower Frame of the Decoder 
Window 

4.2.1 Tag Code Row 

Selecting one of the rows in the Results spreadsheet will open the acoustic waveform plot in the 
visualization window above the spreadsheet (Figure 4.8).  The decoded tag’s relative position in the 
waveform plot and decoded code will be indicated. 

4.2.2 File Length 

The decoder will calculate several potential tag codes per file.  The results derived from the decoding 
are best estimates of the potential tag codes present in the file waveform.  As a result, there may be 
multiple tag code lines in the output spreadsheet with the same file name and possibly the same tag code, 
distinguished from one another by different TOA values.  Multiple tag code lines will increase the .csv 
file length. 

4.2.3 Context Menu 

Right-clicking within the Results spreadsheet opens a Context menu (Figure 4.9).  From the Context 
menu one or more tag codes can be selected and added to the beacon monitoring list by selecting the 
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Monitor Tagcode option (explained further in Section 6.0); the Results Properties can be edited 
(Section 4.1.4.1); or the waveform plot for a specific tag code can be displayed. 

Figure 4.9.  The Context Menu Is Revealed by Right-Clicking on the Results Spreadsheet 

4.2.4 Viewing Tag Code Data Waveforms 

If waveforms are not visible within the Results frame, the window can be expanded or reduced by 
clicking and dragging the thick gray scroll bar (highlighted in red in Figure 4.10 and Figure 4.11) to 
provide more or less space to display tag code data. 
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Figure 4.10. Resize the Results Spreadsheet by Repositioning the Scroll Bar (highlighted in red) 

Figure 4.11.  Resized Results Space after Repositioning the Scroll Bar 
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4.3 Save and Display Options 

Several options available within the decoder program for saving and visualizing data  
(Figure 4.12) are discussed in the following sections. 

4.3.1 Save Only Valid Tagcodes Option 

If the Save Only Valid Tagcodes box is checked (Figure 4.12), the decoder will only save tag codes 
that have a G prefix.  The G indicates that a tag code has passed the checksum test. 

 
Figure 4.12.  Save and Display Options (highlighted in red) 

4.3.2 Show Only Valid Tagcodes Option 

Checking the Show Only Valid Tagcodes box (highlighted in Figure 4.13) instructs the decoder to 
only display tag codes in the result window spreadsheet that have a G prefix.  The G indicates the code 
passed the checksum test.  If this box is checked, and the Save Only Valid Tagcodes box is not checked 
(Section 3.7.1), all tag codes will be saved even though only valid tag codes are displayed.  This program 
feature reduces the number of potentially invalid codes that are displayed and is very useful for 
monitoring the system in the field. 
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Figure 4.13. Tag Code Values with a G Prefix (identified by the red arrow) Are Displayed when the 

Show Only Valid Tagcodes Option is Selected (highlighted in red) 

4.3.3 Insert Results at Top of List Option 

When the Insert Results at Top of List box (Figure 4.12) is checked, the list of tag codes is 
increased by addition of new codes at the top of the spreadsheet.  When this box is not checked, new tag 
codes are appended at the bottom of the spreadsheet. 

4.3.4 Display Tags Option 

The decoder program consumes memory and central processing unit (CPU) cycles to display tag 
codes.  If tag codes are not displayed, decoding can be completed approximately 20 ms more quickly per 
file.  While not a significant time cost for a single code, the time required to display thousands of tag 
codes contained in the data directory can be substantial.  Consequently, it is best practice not to check the 
Display Tags box (Figure 4.12) when performing real-time decoding in potentially noisy environments. 

4.4 Clear Results 

The Clear Results button (highlighted in Figure 4.14), when clicked, will remove data from the 
results window. 
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Figure 4.14.  Clear Results Option (highlighted in red) 

If the decoder is decoding files and the Clear Results button is pressed a Confirm Data Clear alert 
box will appear (Figure 4.15). 

 
Figure 4.15.  Confirm Data Clear Alert Box 
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5.0 Decoding 

Several methods for decoding waveform files are included with this software:  decoding a single file, 
decoding directories, and real-time decoding.  Each is described below. 

5.1 Decoding a Single File 

To decode a single file, press the Decode File button in the Decoder Command Bar (Figure 5.1). 

 
Figure 5.1.  Decoder Command Bar Options (highlighted in red) 

When this button is selected, a file dialog menu (Figure 5.2) will appear. 
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Figure 5.2.  Decode File Open File Dialog Box 

Select the file to be decoded or type the file name in the File name text box.  Select Open to start the 
decode process or Cancel to terminate the Decode File operation. 

5.2 Decoding a Directory 

Post-processing of an existing file, directory, or series of directories, is initiated by selecting the 
Decode Directory button on the Decoder Command Bar (Figure 5.1). 

When Decode Directory is selected, the Directory Options dialog box shown in Figure 5.3 will open, 
allowing data processing options to be selected.  Select options and click Ok to initiate decoding of the 
data in a directory, or Cancel to exit the decoding process. 
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Figure 5.3.  Decoder Directory Options Dialog Box 

5.2.1 Selecting the Decoding Directory 

The directory containing the data to be decoded is selected by entering the preferred name in the 
Directory text box (Figure 5.3) or by pressing the Browse button to locate the required folder.  Selecting 
the Browse button opens the Browse for Folder dialog box (Figure 5.4).  Navigate to the directory to be 
decoded, select the directory, and then click OK.  Selecting Cancel will close the dialog box and no 
changes will appear in the Decode Directory Options dialog box. 
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Figure 5.4.  Decode Directory Browse for Folder Dialog Box 

5.2.2 Include Sub-Directories Option 

To exclude the decoding of sub-directories, i.e., only decode the top-level of a directory containing 
sub-folders, uncheck the Include Sub-directories box (Figure 5.3).  Otherwise, the decoder will process 
files found in the directory specified as well as all sub-directories within the directory. 

5.2.3 Rename Extension After Decode Option 

Checking the Rename Extension After Decode box (Figure 5.3) will instruct the decoder to rename 
the extension of decoded files after decoding is complete.  This is useful for verifying whether data have 
been processed. 
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5.2.4 Use Dates Option 

The Use Dates command (Figure 5.3) allows the file dates to be chosen for files to be decoded.  This 
is useful when reprocessing data or subsampling the data for a given time period, because the directories 
are chosen by date and don’t have to be identified by name.  To use this option complete the following 
steps: 

1. Check the Use Dates box. 

2. Select the start date in the calendar displayed in the From dialog box. 

3. Select the end date in the calendar displayed in the To dialog box. 

Respective From and To dates can also be entered in the numeric spin boxes below the calendars.  
Times are set in the following format:  Month.Day.Year.Hour.Minute.Second.  Values can be reset within 
the day selected in the calendar by pressing the Set Time To Midnight button. 

Because the detector saves files with the date in the name during data acquisition, you can select the 
Set FROM Time Using Filename or Set TO Time Using Filename buttons as shown in Figure 5.5. 

 
Figure 5.5.  Decoder Directory Selection Options 

The name of the file was entered in the spin box for the example shown in Figure 5.5.  When 
selecting the Browse option to choose a file, the Open file dialog box (Figure 5.6) will appear, allowing 
navigation to the required file. 

5.5 



 

 
Figure 5.6.  Selecting the Decode Start Date and Time from a .bwm File 

When the file with the desired start date and time is located, highlight it, select Open, and press the 
Set FROM Time Using Filename button (Figure 5.7) to complete selection of a start date and time.  
When Set FROM Time Using Filename is selected, the date in the From calendar will change to the 
selected file name.  This process can be repeated to select a file to identify the TO date to complete 
identification of the time period over which processing will occur. 

 
Figure 5.7.  Updating the Calendar Using Set From and Set To Times 
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5.2.5 Maximum Number of Threads 

The Maximum Number of Threads field (Figure 5.7) can be adjusted to increase or decrease the 
number of instances of the decoder running at any one time.  If the number of threads is the same as the 
number of cores on the decoding computers’ CPU, the application decodes that number of files 
simultaneously, allowing the application to decode files more quickly.  If the number of threads exceeds 
the number of cores, the application will attempt to decode as many files simultaneously as possible. 

As a rule of thumb, set the maximum number of threads to twice the number of cores available in the 
processing computer if there is no other application that needs to run.  If another application will be 
running at the same time as the JSATS decoder and needs to execute as quickly as possible, such as the 
JSATS detector during real-time decoding (explained in Section 5.3), reduce the maximum number of 
threads to less than the number of cores. 

5.2.6 How Do I Know It Is Decoding? 

When the decoder directory options are configured in the Directory Options dialog box, press the Ok 
button (Figure 5.8). 

 
Figure 5.8.  Select Ok to Start the Decoding Process 
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The decoder Directory Options dialog box will disappear and the main window shown in Figure 5.9 
will start displaying decoded data in the spreadsheet in the bottom frame of the window, indicating the 
decoding progression.  The Decoder Command Bar (Decode Directory, Decode File, Real Time Decode), 
Decoder Options, and Save Command Bar (Result/Save Options and Save Results) buttons at the top of 
the Decoder window will be grayed out and will be inaccessible.  A green progress bar at the bottom of 
the window will indicate the percentage of files processed.  The list of processed files will be 
continuously appended as the decoding progresses. 

 
Figure 5.9. Options at the Top of the Decoder Window (highlighted in red) Are Disabled during the 

Directory Decoding Process.  The progress bar at the bottom of the window (also highlighted 
in red) indicates processing advancement. 

5.2.7 Stopping the Directory Decoding Process 

To stop data decoding within a directory after it has begun select the Stop Decoding button 
(highlighted in Figure 5.10).  The results from files that have been processed will be saved automatically 
to the Results file. 
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Figure 5.10.  Select the Stop Decoding Button to Terminate a Directory Decode 

5.3 Real-Time Decoding 

Real-time decoding is accomplished when the JSATS detector and decoder are running 
simultaneously.  When the JSATS detector is running and collecting files, the decoder can automatically 
access and decode the new waveform files created by the detector.  This assists in managing the number 
of waveform files saved because post-processing will not be required and waveform files can be decoded 
as they are acquired, then discarded.  However, if retaining waveform files after decoding is required for 
future investigation, the decoder can rename the waveform file names extension and save the processed 
files. 

5.3.1 Real-Time Decoding 

Real-time decoding is customized and launched by selecting the Real Time Decode button 
(highlighted in Figure 5.11). 
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Figure 5.11.  Real-Time Decoding Option (highlighted in red) 

When the Real Time Decode button is selected, the Real-Time Decoder Options dialog box shown in 
Figure 5.12 opens. 

 
Figure 5.12.  Real-Time Decoder Options Dialog Box 

5.10 



 

Enter the name of the directory where the JSATS detector has been directed to save data into the 
Directory text box (Figure 5.13).  Confirm that you are decoding candidate tag waveforms from only one 
receiver board with the JSATS decoder.  Multiple copies of the JSATS decoder can be run to real-time 
process waveform files from multiple receiver boards simultaneously if enough cores are available on the 
CPU to handle the additional processing.  A multi-core CPU or computer with multiple CPUs is 
necessary to operate real-time decoding during data acquisition. 

 
Figure 5.13.  Real-Time Decoder Directory Selection 

As a directory name is entered, the text box will suggest directory names that are available on the 
computer.  The directory may also be located by pressing the Browse button and navigating to the 
directory in the Browse For Folder dialog box (Figure 5.14). 

5.11 



 

 
Figure 5.14.  Real-Time Decode Directory Browse for Folder Option Dialog Box 

5.3.2 Include Sub-Directories 

Real-time decoding can be achieved with a single directory or, if the Include Sub-directories option 
is selected, a directory and its sub-directories (Figure 5.12).  It is recommended that the Include Sub-
directories option always be selected. 

5.3.3 Rename Extension After Decode 

The Rename Extension After Decode option (Figure 5.15) will rename decoded files with a .com 
extension, by default.  When this option is selected, the renamed files will be saved and the Delete File 
After Decode box will be inaccessible (Section 5.3.4).  The Rename Extension After Decode feature is 
very useful if all waveforms are being saved, including those that have been decoded, and the decoder 
cannot keep up with the number of incoming waveform files.  If the number of candidate tag waveforms 
to be processed by the decoder overwhelms the real-time feature of the decoder, the user can post-process 
the remaining files later using the Decode Directory option (see Section 5.2).  The decoder will only 
decode files that have the .bwm extension; it will ignore files that have other extension designations. 
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Figure 5.15.  Real-Time Decoder Options Dialog Box 

The extension of the renamed file can be changed from .com to any extension if the file 
“JSATSDecoder.net.exe.config” file is modified with a text editor (e.g., Notepad or WordPad).  This 
configuration file can be found in the directory in which the JSATS decoder program was installed on the 
computer, usually the JSATS Decoder Program Files directory (Figure 5.16).  Near the bottom of the file, 
there is a RenameExtension setting.  Within the two <value></value> tags, the extension can be changed 
from .com to the desired extension, such as .cmp (Figure 5.17).   

 
Figure 5.16. The JSATS Decoder Configuration File Is Commonly Located in the Program Files 

Directory 
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Figure 5.17. The File Extension for Renamed Files Can Be Changed by Modifying the Configuration 

File 

5.3.4 Delete File After Decode 

Selecting the Delete File After Decode checkbox (Figure 5.15) will result in waveform files to be 
deleted after they have been decoded.  As a precautionary measure, this option is not set by default to 
avoid deleting files until all aspects of data flow through the JSATS receiving system have been verified 
to be functioning as intended. 

5.3.5 Milliseconds Before Decoding 

The decoder will pause for a few milliseconds prior to decoding a newly saved file, allowing the 
detector to finish writing the file to disk.  The recommended wait time is 100 ms—the default value in 
the Milliseconds before decoding spin box found in the Real-Time Decoder Options dialog box  
(Figure 5.15).  If the wait time is too short, the decoder will attempt to read the waveform before the 
detector has completed writing the file to disk and the system will crash. 

5.3.6 Maximum Number of Threads  

Selection of the Maximum Number of Threads in the Real-Time Decoder Options dialog box 
(Figure 5.15) has the same effect as the selection of the maximum number of threads in the Decode 
Directory dialog box (Section 5.2.5). 

The Maximum Number of Threads option allows the user to increase or decrease the number of 
instances of the decoder running at any one time.  If the number of threads is the same as the number of 
cores, the application will decode that number of files simultaneously, allowing the application to decode 
files more quickly.  If the number of threads exceeds the number of cores, the application will attempt to 
decode as many files simultaneously as possible. 

When using real-time decoding, it is best practice to increase this field to as high as possible without 
affecting other applications.  The maximum value of the field is twice the number of CPU cores.  When at 
the maximum, the JSATS application will consume 100% of the CPU cycles available if files are being 
detected at a high rate. 
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5.3.7 Cache Expiration Time (mins) 

The Cache expiration time (mins) option (Figure 5.15), found in the Real-Time Decoder Options 
dialog box, is the maximum amount of time the application will store tag codes in the buffer memory 
before writing them to file.  For example, if the cache limit is 1000, and the expiration time is 30 minutes; 
when the decoder collects 200 tag codes in 30 minutes, it will write all 200 to the results .csv file.  If it 
collects 1000 tag codes in 15 minutes, with the same expiration time, all 1000 will be written to the 
results .csv file after 15 minutes.  This feature is useful in quiet environments or other circumstances 
when the number of candidate waveforms per unit time is low. 

 

 

5.15 





 

6.0 Beacon Monitoring 

This section describes an advanced decoder feature—beacon monitoring.  This option monitors the 
codes transmitted by beacons deployed in the study area.  Receiving and monitoring beacon transmissions 
assists in verifying the operation of hydrophones in a JSATS receiving array and are used to estimate 
detection range and detection efficiency.   

6.1 Statistics and Beacon Monitoring Window 

Select the Statistics and Beacon Monitoring tab in the Decoder window to open the beacon 
monitoring options and related controls (Figure 6.1).  Selections include Load Beacon File, Save Beacon 
List, Add, Delete, Edit Selected Beacon, Stats Options, Delete Beacons, and Clear Statistics. 

A list in the upper frame of the Decoder window displays beacons that were entered manually (see 
Section 6.2), beacons added using the context menu option (Section 4.2.3), or beacons added by file 
selection (see Section 6.6).  Figure 6.1 shows three beacons in the beacon list. 

 
Figure 6.1.  Statistics and Beacon Monitoring Options 
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The beacon information contained in the spreadsheet includes the following: 

• Beacon Name – an alias assigned to the beacon by the program user 

• Tagcode – the code transmitted by the beacon, the code must include a G at the beginning of the tag 
code 

• Hydrophone Name – the alias for the hydrophone receiving the beacon code (assigned in the Detector 
software) 

• Status – decoder assessment of the operating status of the beacon 

• Expected Ping Rate – the number of transmissions per unit time by the beacon 

• Average Ping Rate – the number of transmissions per unit time observed for the beacon 

• Counts – the number of times the beacon has been detected within a period of time 

• Last Seen – the last time the beacon was detected. 

6.2 Adding a Beacon to the Statistics and Beacon Monitoring List 

To manually add a beacon, press the Add button in the Statistics and Beacon Monitoring window 
(Figure 6.1), which will open the Edit Beacon dialog box.  Enter the beacon information in the Edit 
Beacon dialog box and press OK to accept the changes or the Cancel button to reject the changes (Figure 
6.2).  Tag codes can also be added to the beacon list by selecting a row(s) in the Results file, right-
clicking to open the Context menu, and selecting Monitor Tagcode from the options (Section 4.2.3). 

 
Figure 6.2.  Edit Beacon Dialog Box 
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6.3 Deleting a Single Beacon 

To delete a beacon, select the beacon from the list by clicking on the row, which will highlight the 
row in light gray (Figure 6.3).  When the Delete button is selected, the beacon will be removed from the 
list.  

 
Figure 6.3.  To Delete a Beacon, Highlight the Row and Select Delete 

6.4 Deleting All Beacons from the List 

To delete all beacons from the Beacon List, press the Delete Beacons button (Figure 6.1). 

When the Delete Beacons button is pressed, an alert dialog box will open (Figure 6.4) requesting 
confirmation of the command to clear the beacon list.  Select Yes to clear all beacons from the list or No 
to cancel the Delete Beacons command.   

 
Figure 6.4.  The Confirmation Dialog Box to Delete All Beacons on the List 

6.5 Editing a Beacon 

To edit the information for a beacon, select the beacon from the list and press the Edit Selected 
Beacon button (Figure 6.1).  The Edit Beacon dialog box will open (Figure 6.2).  Edit the beacon 
information as needed, then press OK to accept changes or Cancel to reject the changes. 
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6.6 Loading a Beacon File 

Beacon information can also be entered into the beacon list using an ASCII text file.  Each line of the 
file contains the information for one beacon in the correct file format, as described in Section 6.1.  An 
example text file displaying three beacons as viewed with Notepad is shown in Figure 6.5. 

 
Figure 6.5.  Beacon List File Example Using Notepad 

The sequence of operations to load a beacon text file is initiated by pressing the Load Beacon File 
button (Figure 6.1).   

Navigate to the beacon text file in the Open file dialog box and initiate it by clicking the Open button 
(Figure 6.6).  The file loads to the spreadsheet as shown in Figure 6.7. 

 
Figure 6.6.  The Text File Containing Beacon Information Is Selected from the Open File Dialog Box 
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Figure 6.7.  Beacon List Loaded from an ASCII Text File 

6.7 Saving a Beacon File 

When a beacon list is complete, it is saved by pressing the Save Beacon List button (Figure 6.1). 

When the Save Beacon List button is selected the Save As file dialog box opens (Figure 6.8).  Create 
or navigate to the directory to which to save the beacon list and type the name of the new beacon list file.  
Select the Save button to save the file or Cancel to reject the process. 
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Figure 6.8. When Saving a Beacon List the Save As Dialog Box Opens, Prompting Insertion of a File 

Name 

The decoder keeps a local list of all manually added beacons or those loaded using ASCII text files.  
The Save Beacon List function saves a beacon list as a file that can be loaded into the decoder program 
running on other computer systems. 

6.8 Setting Statistics Options and Saving Stats Options 

The details for the computation of beacon statistics can be changed by pressing the Stats Options 
button (Figure 6.1). 

Pressing the Stats Options button opens the Statistics Options dialog box shown in Figure 6.9. 
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Figure 6.9.  Statistics Options Dialog Box 

6.8.1 Compute Statistics 

In the Statistics Options dialog box, the Compute Statistics box must be checked for statistics to be 
computed for tag codes or beacons (Figure 6.9). 

6.8.2 Time Period for Computing Statistics  

The Compute Statistics Over option identifies the time period in hours, minutes, and seconds within 
which the decoder will compute statistics.  Statistics are calculated over a moving window of the duration 
specified.  By default the duration is an hour, as shown in Figure 6.9. 

6.8.3 Tag Codes Required to Compute Statistics 

The Require [—] Tagcodes to Compute Status option designates the number of observations the 
decoder will make before computing the statistics needed to report beacon status (Figure 6.9). 

6.8.4 Ping Rate Tolerance 

The average ping rate value will seldom exactly match the expected ping rate value.  The Ping Rate 
Tolerance option allows the user to set a specific range within which the average ping rate can vary and 
still be considered to be working correctly.  The example in Figure 6.9 shows a ping rate tolerance range 
of +/- 3 seconds. 
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6.8.5 Saving Statistics  

The Save Statistics Every [—] Minutes checkbox and spin box instruct the decoder how frequently 
to save statistics to the statistics file described in Section 6.8.6.  The Save Statistics Every  
[—] Minutes box must be checked to enable the save function (Figure 6.9). 

6.8.6 Saving Beacon Statistics 

The To Location text box identifies the location where the statistics file will be saved.  During each 
save, the new statistics will be appended to the statistics file.  Enter the directory and name of the file in 
the text box or press the Browse button, navigate to the preferred directory, and enter a file name 
(Figure 6.10).  Select Open to save or Cancel to reject the process. 

 
Figure 6.10.  The Open Dialog Box where Beacon Statistics Will Be Saved 

6.9 Clearing Statistics 

The beacon statistics being displayed in the Decoder window can be cleared by pressing the Clear 
Statistics button (Figure 6.1).  The results will be deleted and will not be saved unless saved previously. 
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7.0 Data and File Formats 

File formats for beacons, beacon statistics, and decoder results are described in this section. 

7.1 Beacon File Format 

The beacon file configuration is a comma separated file format as shown in Figure 7.1.  The columns 
within a row for a single beacon are as follows: 

• Beacon Name  

• Beacon Tagcode 

• Hydrophone Name 

• Expected Ping Rate  

• X Position 

• Y Position 

• Z Position. 

 
Figure 7.1.  Beacon File Format Example 

The X, Y, and Z position columns are not used by the decoder and are only placeholders to indicate 
the location of the beacon if needed for reference purposes. 
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7.2 Beacon Statistics File Format 

The beacon statistics file (Figure 7.2), which is appended after every Save Beacon Statistics 
procedure, has the following format: 

• Statistics Heading – Time and Date of save 

• Column Headings:  

– Beacon Name  

– Beacon Tagcode  

– Hydrophone Name  

– Expected Ping Rate  

– Average (or observed) Ping Rate 

– Position X  

– Position Y  

– Position Z. 

 
Figure 7.2.  Beacon Statistics File Format 

Specific time and date statistics and column headings are repeated each time the file is appended. 

7.3 Decoder Results File Format 

The Results file is formatted as shown in the Excel spreadsheet in Figure 7.3.  Data rows are 
configured as follows:  

• The first line is blank. 

• The second line describes the decoder’s assembly file, useful developer information for 
troubleshooting. 
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• The third line describes the decoder type (name), version, and options. 

• The fourth line contains the column headings. 

• The next lines are the data.  Each line represents a single tag code, possibly from the same 
hydrophone, possibly from the same file. 

 
Figure 7.3.  Results File Format 

The data columns contain the following information: 

• FILEPATH – directory name of the decoded waveform file 

• FILENAME – file name  

• HYDROPHONENAME – name of hydrophone where the tag waveform was detected 

• FILETIME_SEC_FROMMIDNIGHT – seconds from midnight (fractional) when the file was created 
using GPS clock 

• SIGNALTIME_SEC_FROMMIDNIGHT – seconds from midnight (fractional) when the tag signal 
was detected using the JSATS receiver GPS clock 

• TAGCODE – tag code decoded from the detected waveform 

• TOA_MICRO_SEC – time of arrival relative to the start of the file in microseconds signal when the 
waveform was decoded 

• SNR_DB – Signal-to-noise ratio in decibels – SNR for the waveform relative to the background noise 
of the environment 

• CRC – cyclic redundancy check computed over the 16-bit binary representation of the tag code 

• PHASEMARGIN – confidence metric for binary phase-shift keying phase transitions 

• CHANNEL – data channel. 
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8.0 Command Line Decoder 

The Command Line decoder is a lightweight version of the JSATS decoder.  This version is intended 
for post-processing of .bwm files and is not designed for real-time decoding.  All major post-processing 
functionality in the graphical user interface (GUI) version of the JSATS decoder is available in the 
Command Line decoder. 

The argument format for the Command Line decoder is as follows:  

JSATSDecoderCommandline.exe <directory containing .bwm files> [-r to check sub-
directories] [- o .csv file name] [-p to use parallel processing].   

The path to decode is required; the options (parallel, out file, and parallel) are not.  By default, only 
top-level directories are searched, waveform files are decoded serially, and output is written to results.csv 
files and will be in the same directory as the program. 

For example, to decode all waveform files in the directory C:\.bwm Files, the following command is 
entered: 

>JSATSDecoderCommandLine.exe “C:\.bwm Files” 

Decoding speed can be increased using parallel decoding.  To enable parallel decoding, the following 
command is entered: 

>JSATSDecoderCommandLine.exe “C:\.bwm Files”-p 

If the results are to be saved to C:\myResults.csv and decoded in parallel, the following command is 
entered: 

>JSATSDecoderCommandLine.exe "C:\.bwm Files" -p -o C:\myResults.csv 

To check all the files in the C:\.bwm Files sub-directories, the –r option is used: 

>JSATSDecoderCommandLine.exe “C:\.bwm Files” –r 

For example, two hard drives labeled E: and F:, respectively, contain tag waveforms to be decoded.  
Decoding needs to be completed as quickly as possible, so the decoders will be run on the processing 
computer and results will be saved on the computer desktop. 

Two instances of the Command Line decoder prompts are needed to decode the waveform files on the 
hard drives.  The first prompt is 

>JSATSDecoderCommandLine.exe “E:\” –p –r –o “C:\Users\User\Desktop\e drive.csv” 

After entering the first prompt, press Enter and select the second prompt.  The second prompt will 
be: 

>JSATSDecoderCommandLine.exe “F:\” –p –r –o “C:\Users\User\Desktop\f drive.csv” 
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After the prompt has been completed, press Enter to begin processing the waveform files.  The 
format of the results files from the Command Line decoder will be of the same format as the GUI version 
of the JSATS decoder (see Figure 7.3). 
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